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How-to: Print jobs correctly once with Fiery JobExpert

Feature overview

Fiery JobExpert is a breakthrough new technology
that analyzes incoming PDF files and dynamically
chooses the optimal print settings to achieve the
highest quality, while optimizing production time.

To accomplish this, Fiery JobExpert will:

Analyze each PDF print job in detail

Automatically set the optimal Fiery job
settings

Process each job to efficiently achieve the
best possible print quality

JobExpert serves as built-in expert that delivers:

Highest print quality
Faster processing

Enables less-experienced operators to run
jobs correctly

Reduces setup time
Cuts waste

And can be undone if needed

Objectives

Import a document using Fiery JobExpert in
Fiery Command WorkStation®

Check the automatic corrections done by
JobExpert

Apply Fiery JobExpert to a job already
imported in the Held queue

Clear Fiery JobExpert settings applied to a
job

Preview Fiery JobExpert Report applied to a
job

Additional resources

For additional software downloads, training
resources, and more, go to Fiery Online Resources.

Before you begin

Open Fiery Command WorkStation 6.4 or
later and connect to a Fiery external server
running Fiery FS400 Pro*.

Have a copy of the files on your desktop:
efi_fiery_MnM_booklet_jobexpert_A4.pdf or
efi_fiery_MnM_booklet_jobexpert_LTR.pdf

Ensure that the printer and Fiery server have
been calibrated before printing any output.

* Some exceptions apply. Please check feature availability with

your Fiery reseller.


http://efi.com/resources/fiery-online-resources/
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Import a document using Fiery JobExpert in Fiery Command WorkStation

In this section you will import a PDF file to Fiery Command WorkStation, apply JobExpert to it, and
then import the same file without JobExpert applied for later comparison.

For the first PDF file, JobExpert will choose the optimal Job Properties settings based on the content
of the job.

1. To begin, import the efi_fiery_MnM_booklet_jobexpert_LTR.pdf or
efi_fiery_MnM_booklet_jobexpert_A4.pdf file to the Fiery server using Command
WorkStation. Select the File menu and then choose the Import job... option. Alternatively, you
can use the Import toolbar icon located in Job Center.

# Fiery Command WorkStation
File Edit Actions Server View Help
Import Job... Ctrlsl ©) Idie ¥ HELD ( 1 2)
Import Archived Job
New Job... Ctrl+N

PROCESSING

Idle
Export Current View

3, Import [ 3 New Job

Exit

Job Status Job Title

~ HELD (12)

Note: Depending on the media stock size that you have available on your Fiery server trays,
you can select the A4 version of this file, the JobExpert results will be the same.

2. On the new Select Files to Import window select the PDF file located on your Desktop and
then click Open to add.

3. A new window called Import Files will appear showing the PDF’s file name, size, and type.
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4. Click on the Apply JobExpert checkbox located in the lower-left corner of this window.

Fiery JobExpert
JobExpert analyzes the PDF file and defines the best job settings to achieve the highest output quality.

Apply JobExpert | All categories v

Hold Process and Hold |+ Cancel

5. Atfter clicking on the checkbox, a drop-down list selection will be activated. For this example,
leave the ‘All categories’ option selected. JobExpert will choose the best Job Properties
settings based on the content of the job.

Note: When the All categories option is selected, Fiery JobExpert automatically sets the correct print
settings for color management, image quality, variable data, and some engine-specific properties.

When Color Management is selected, JobExpert will choose the best color settings based on the
content of the job.

After the job is analyzed by JobExpert, you can check the applied settings by opening the Color tab
in Job Properties. If needed, JobExpert will also enable Adobe PDF Print Engine (APPE) in the job.

Using the Image Quality option, JobExpert will choose the best image quality settings based on the
content of the job.

After the job is analyzed by JobExpert, you can check the applied settings by opening the Image tab
in Job Properties.

When VDP option is selected, JobExpert will choose the best settings in Job Properties for PDF jobs
that contain variable data. If PDF/X objects are detected in the job, JobExpert will also enable APPE.

6. Then, select Process and Hold job action, and JobExpert will automatically apply the
recommended settings to that job.

Now, you will import the same file one more time, but you will not use Fiery JobExpert.

1. Select the File menu and then choose Import job... option. Locate the PDF file
efi_fiery_MnM_booklet_jobexpert.pdf on your Desktop and select it.

2. In the new Select Files to Import window, click Open to add.

A new window called Import Files will appear, don’t change any of the settings and click the
Process and Hold button.

Look at the Held queue, you will see the PDF file efi_fiery_MnM_booklet_jobexpert.pdf listed two

times.
&, Import @ Print  [7) Properties.. Q Preview 3 NewJob [ Delete 2f Calibrate.. (&) SpotPro 4ff Logs
Job Status Job Title User Size Pages Copies Date/Time
59 Processed efi_fiery_ MnM_booklet_jobexpert_LTR_hg.pdf Admin 67.0MB 4 1 Today 5:15:42 PM
59 Processed efi_fiery_MnM_booklet_jobexpert_LTR_hg.pdf Admin 2193MB 4 1 Today 5:13:27 PM
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Check the automatic corrections done by JobExpert

In this section, you will see how JobExpert settings can be applied to PDF files imported into Fiery
Command WorkStation.

EFI has developed extensive checks to detect embedded ICC profiles, transparency issues, small
texts and ultra-thin lines.

To check some of these settings and corrections, you can use Preview in Fiery Command
WorkStation, however some corrections can only be checked on a printed document.

Using the Preview option, you can visually check if an embedded ICC profile was correctly honored
using JobExpert on a Fiery server.

JobExpert will detect profiles in incoming PDF files whether they are RGB, CMYK, gray — or even
when there is an embedded output intent profile. Let's see how to check that.

Locate the latest imported PDF file efi_fiery_MnM_booklet_jobexpert.pdf that was proceed
without Fiery JobExpert in the Held queue.

Do a right-click on it.
From the context menu, select the Preview... option.

At the bottom of the first page, you can see two pictures. The one at the right of the page has
a custom CMYK ICC embedded profile that was not processed properly. You can visually see
that the image has a magenta cast.

Image processed without JobExpert.

Now, compare the same PDF that processed using Fiery JobExpert.

1.

Locate the first imported PDF file efi_fiery_MnM_booklet_jobexpert.pdf that was proceed
using Fiery JobExpert in the Held queue.

Right-click on the PDF.
From the context menu, select the Preview... option.

Take a look at the two pictures at the bottom of the first page again. The image on the right
has a custom CMYK ICC embedded profile. Now with JobExpert applied, the image was
processed correctly with the embedded ICC profile and there isn’t a magenta color cast.
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To compare which settings were used for each job, we can compare the job properties for these two

examples.

1. Select the two jobs efi_fiery_MnM_booklet_jobexpert.pdf in the Held queue that were used

Image processed with JobExpert applied.

in the previous examples.

Right-click on one of them.

Select the Properties option from the context menu.

Then click on the Summary tab.

S

In the Color section you can check all the settings that were configured based on the PDF
content. Please check that the setting ‘Use CMYK embedded profiles’ are set to ‘Off and ‘On’
for each processed PDF.

Job: All(2) v||e]» Presets: v

BUIRL SR (@] Adobe PDF Print Engine Preferred Print Summary...

JOB INFO

efi_fiery MnM_booklet_jobexpert_LTR h... efi_fiery_ MnM_booklet_jobexpert_LTR h... *

MEDIA

¥ Quick Access

¥ Job Info
» Media
COLOR » Layout
IMAGE ¥ Color
On On
FINISHING Use job defined settings Use job defined settings
CMYK CMYK
vOP sRGB (PC) sRGB (PC)
STAMPING Off On
Photographic Photographic
K suMMARY off off
GRAC0L2013 CRPCE (EFI) GRAC0L2013 CRPCE (EFI)
Off On

Relative Colorimetric
On

Relative Colorimetric
On

Text/Graphics/Images Text/Graphics/Images
Dot Gain 20% Dot Gain 20%
Off On

Relative Colorimetric

Print

Relative Colorimetric

g

Cancel
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Fiery JobExpert can also correct several other settings including:

Color Spaces and Spot Colors

S
SN
{M )
NS
MANOR & MASON

TASTE + CULTURE + TRAVEL

Without JobExpert

Without JobExpert

AR
{m)

MANOR & MASON

TASTE + CULTURE + TRAVEL

With JobExpert

With JobExpert

Transparencies

NEW COOKING CLASSES, CULINARY DESTINATIONS,
GOURMET PRODUCTS AND KITCHEN TOOLS
{4 : X 4

NEW COOKING CLASSES, CULINARY DESTINATIONS,
GOURMET PRODUCTS AND KITCHEN TOOLS

Without JobExpert

With JobExpert

Small texts

COLD
EXTRACTION

Without JobExpert

COLD
EXTRACTION

With JobExpert
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Ultra thin-lines

Without JobExpert With JobExpert

APPE to ensure correct output.

Copper egg white bow!
with ring. Available in

multiple sizes.

Without JobExpert With JobExpert

Apply Fiery JobExpert to a job already imported on Held queue

In this section, you will see how to apply JobExpert settings to a PDF file that was already imported,
without using the Fiery JobExpert feature.

1. Locate the job you want to apply JobExpert in the Held queue.
2. Right-click on the job name.
3. From the context menu, choose Apply JobExpert option.

4. Choose Server's default from the pre-defined settings available.



How-to: Print jobs correctly once with Fiery JobExpert

Fiery Command WorkStation will automatically apply the JobExpert on the selected PDF file, showing

a progress bar on the Job Status column in the Held queue.

JobMaster... ~ HELD (14)
Merge Jobs...
3, Import Iﬁ; New Job
Apply JobExpert Server's default
Archive Image quality Job Status Job Title
Color management Y - efi_fiery MnM_booklet_jobexpert_LTR_hg.pdf
o 89 Processed efi_fiery_ MnM_booklet_jobexpert_LTR_hg.pdf

Note: You can only apply Fiery JobExpert on any job that was not processed yet. So, it's necessary
to remove the raster data from a processed job before applying JobExpert. Select the processed job
file in the queue, right-click on it and select the Remove Raster option from the context menu.

Clear Fiery JobExpert applied to a job

If you need to undo the JobExpert settings for any job, you can remove this feature with just one click.

1. Locate and select the job you want to remove the JobExpert functionality from the Held
queue.

2. Right-click on the job name.
3. From the context menu choose Clear JobExpert option.

Fiery Command WorkStation will automatically revert to the previous settings on the selected PDF file
in the Held queue.

Process and Hold 4
Copies :

Preview... 1/

Image Enhance Visual Editor... Media

Togs.. 8.5x11, Color specific,
Last calib

Properties... Default measurements

Apply Workflow >

Preflight : £
Preflight... Not Preflighted

Impose... Proce
JobMaster...

Merge Jobs... JobExpert
Server's default Clear
Clear JobExpert
> < >

Archive »

Alternatively, you can also clear the JobExpert setting using the Summary Panel.
1. Locate and select the job you want to remove JobExpert in the Held queue.
2. From the Summary Panel area, click on the Clear link.

Fiery Command WorkStation will automatically clear the JobExpert settings on the selected PDF file
in the Held queue and assign the default settings.

Note: You can only clear Fiery JobExpert on a job that is not processed. Therefore it's necessary to
remove the raster data from a processed job. Select the processed job file in the queue, right-click on
it and select the Remove Raster option from the context menu.
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Preview Fiery JobExpert Report applied to a job

After applying JobExpert to a job, you can use the JobExpert Report to see a summary and
explanation of the settings optimized for the job. Plus you can use the preview functionality to
visualize the elements that require specific settings to be enabled.

There are two ways to access the JobExpert Report. The first is to right-click the job’s name in the job
queue and choose the View Report from the context menu. The second is to click on the View Report
link under the JobExpert information in the Job Summary area.

NE) o
FRocESSG
Idle

@ Fiery Jobbxpert - x

© Job properties optimized for 256 objects

* HELD (79) > Search Results (2 m a -~ | % |5 88
PROCESSING Py Image smoothing - On K

3, import 9 Print 1) Properties
PRINTING 0 oL impott & prnt [ Prop © Applied to 16 i

HELD

PRINTED

ARCHIVED

e Job Status Jobxpert rull enabled to minimize jaggy output when printing low ertype  Outputpapersie  Workfiow

[ spooled A categores

Preview not availabe!
[ Spooled

K
abled, The Fies
colors that the copt

v JOB SUMMARY

»  Cache PDF and PS objects - On K
© Applied to 25 instances
Cache PDF and PS objects have been enabled to process the job faster.

@\ Use RGB embedded profiles - On E
®' @ ppplicd to 16 i
Obje
been ensble

have been found. Use RGB embedded profiles has

> Composite overy
© Appli
Composi

%3] Optimize RGB transparency - On K
*¥ @ Anoliad ta @ inctancac

Once the report is open, you can see which preset was used and the total number of instances that
were optimized by JobExpert.

Also, you can view the explanation about each setting applied and how many times it was used.

If you click on a setting that was enabled, a new window will pop up to show you the elements that
required the setting to change within the document. You can cycle through the settings preview by
clicking on the Previous or Next buttons, selecting a different zoom factor, and also changing the
background color to assist in viewing the elements that were affected in the document.
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EFI fuels success.

We develop breakthrough technologies for the manufacturing of signage, packaging,

textiles, ceramic tiles, and personalized documents, with a wide range of printers,

Inks, digital front ends, and a comprehensive business and production workflow suite

that transforms and streamlines the entire production process, increasing your

competitiveness and boosting productivity. Visit www.efi.com or call 650-357-3500 P
for more information. Ef 7
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Nothing herein should be construed as a warranty in addition to the express warranty statement provided with EFI products and services
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